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This chapter describes the ways in which you can customise
Ovation Pro for general use or for specific applications.

Stylesheets fully describe the format and style of documents. You can
save the stylesheet from a document and use it as a template for
creating other similar documents. You may also save a stylesheet so
that it is used as default for each new document opened.

Application Choices allow you to configure the application in various
ways. There is just one set of Choices that affects all documents.

Document Preferences allow you to configure individual documents.

In addition to the above options, you may also customise the button bar
(see Chapter 16) and the menus (see Chapter 17).
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15.1 Stylesheets The following information is saved in stylesheets:
Menur>Filer>Save stylesheet » Defined styles
The Savestylesheetoption opens the usual » Defined colours

Windows save windowfig 15.1) which allows . Master pages
you to save a stylesheet for the current document.
The procedure for saving a stylesheet is identical®
to that described previously for saving documents  View options, Grid and Zoom

(see 3.9) » Toolbox and info palette position
The stylesheet describes the format and style of
the document from which it is saved, but it doesn't . ) )
have any actual contents. Whenever you save a Please note that objects, text and.plctures in the
document, its stylesheet is automatically saved document pages are NOT saved in stylesheets.
with it. However, if you want to use the same

layout for other documents, you can save the

stylesheet separately.

Objects on the master pages.

Preferences

A stylesheet may be re-loaded just like any other
document i.e. by double-clicking on it, or using
Open on th®vation Pro File menu.

So if you want to create a new document based on
the style of an existing document, save the
stylesheet from the document, then double-click
on the stylesheet to create a new document. Every
time you need to create a new document having
the same layout, just load the stylesheet from disc.

Save As HE
Save in; I _4 Manual j gl

| 1172_Examples

File name:

stylesheet Sawve I
Save as type: IDTP Style Sheet (*.dps) j Cancel |

Fig. 15.1 - The Save stylesheet window.
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15.2 Changing the Default Document
Menur>Files>Save as default

The Save as defaulbption allows you to

overwrite the default document with a stylesheet

based on the current document. The default
document is the blank document that appears
when you click on New on th@®vation Pro File
menu and then click on OK.

To change the default document:

1. Click on New on th®vation Pro File menu
and then click on OK to open a blank

document (or load any other document whose

layout you want to use).

2. Modify the document as requiregdvation Pro
uses a stylesheet to define the default
document, so you may change any of the
attributes that are saved in stylesheets
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A feature for advanced users, is that it is possible
to save a document (i.e. as opposed to a
stylesheet) as the default document. This has to be
done manually by opening the foldevation Pro
saves fileDef aul t . dps in. This is in the
Application Data folder for the current user. A
typical path for it is:

C:\Documents and Settings\David
Pilling\Application Data\DavidPilling\OvationPro

The first “David Pilling” being replaced with your
user name.

If you do this, the first object of each type in the
document which is not a master object is used as a
prototype.

By this mechanism it is possible to make new text
frames default to transparent fill or have no text
runaround etc.

(see 15.1)Typically you might want to change Sometimes this approach will overlap with
the page margins, document zoom, defined options in the choices window being provided to

styles or colours.

Note that the default document cannot contain®
objects, text or pictures, except those on the

master pages.
3. Click onSave as defaulto save the current

control the defaults for objects (see below).
ettings in the choices windows take precedence.

document as the default document. You will be

prompted for confirmation before the old
default document is overwrittgfig. 15.2)

4. Click on New on th®vation Pro File menu
and then click on OK to open a new default
document.

T Ovation Pro

~

@'0 About to update default document. Are
A you sure you want to proceed?

N\
Ma | fes

Fig. 15.2 - Confirmation box when using Save as default.
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15.3 Application Choices
Menur>Miscr>Choices...........
ChooseChoicesfrom the Misc menu to open a

dialogue box that allows th@vation Pro
application to be configurgdig. 15.3)

Note that choices are attached to the application,

and affect all the documents that you create or
load i.e there is one set of choices for all

documents.

There are seven groups of choidesnt,
General, View, Text, Picture, Line andColour.

Click on the appropriate icon in the scrolling pane

at the left of the dialogue box to display all the

associated choices. The choices are described on

the following pages of this user guide.

Once you are happy with the choices, clickQit
to apply them for the current session only.

Alternatively, click onSaveto apply the choices

and save them so that they will be used by default

next timeOvation Pro is run. You will be

prompted for confirmation before the old choices

are overwritten.

In addition to the settings in the choices dialogue

box, clicking onSavealso saves the order of the
tools in the toolboXsee 2.6)

¥ Application choices |

=

Print

- |

™ Crop check

Frint choices

™ Mail merge one record per print job

ﬂ“l? W Direct PostScript output 'El
.%Y,.v"
_General | Bleed | 3mm
@? Reg. width | 0.03mm
_ Miew Crop H length | 7mm Gap| 3Imm
ﬁE Crop % length | 7mm Gap| 3mm
= T
Text Reg. H length | Brmm Gap| 4.5mm
*‘|'.._;ﬂ1 Reg. % length | 4mm Gap| 4.5mm
B
F'iciLre - Reg. radius | 1.5mm
Save Cancel 0]%

Fig. 15.3 - The Choices dialogue box
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15.4 Print Choices

Menu=>Misc=> Choices>Print

For all available choicesee fig. 15.4

Crop check

If Crop checkhas been selected you will be
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Bleed and the following icons

If Bleedis selected an additional margin all
around the page is printed. Useful if you want an
object to go to the edge of the pafsre 12.3 and
fig. 12.10)

The other icons let you set the sizes of the crop
and registration marksee 12.3 Printers marks).

alerted if the area being printed is bigger than the
available area on the printer.

Mail Merge...

If off a mail merge will produce one print file (or
print job) containing all the merged versions. If
set then a file (or print job) will be produced for

each merged version. This may make more sense

if you recall that some printing services append a
cover sheet to each print job, a fax printer may

make a phone call for each print job.

Direct PostScript output

If selectedOvation Pro will send data direct to
PostScript printers, bypassing the printer driver

(see 12.4 PostScript Printing)

[ Crop check

Print choices

™ Mail merge one record per print job

¥ Direct PostScript output *E||

Bleed

ey, width
Crop H length
Crop % length
Feqy. H length
Reqy. v length

Feq. radius

Fig. 15.4 - Print choices.

3rnrn|

[ 009mm
il Gap 3mim
fmm Gap| Jmm
Emm Gap| 4.5mm
A Gap 4.4rmim
1.8mm
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15.5 General Choices

Menu=>Misc=>ChoicesyGeneral

General choices are associated with the general
operation ofOvation Pro (fig. 15.5).

Date Format

Date format sets the format of the date string
inserted by thdlenur>Miscr>Insert=>Date
option(see 3.2)A full explanation of this format
is given inAppendix D

Time Format

Time format sets the format of the time string
inserted by thdlenur>Miscr>Insert=>Time
option(see 3.2)A full explanation of this format
is given inAppendix D

Save Buffer

If Save bufferis not selected, the undo buffer is
flushed whenever documents are saved.

If Save bufferis selected, the undo buffer is
saved with document{see 3.4)This means that
when you reload the document, you can undo
operations that were performed in a previous
session. Another advantage is that when you

CHapPTER 15

Buffer Size

Buffer sizeis the size of the undo buffer. The
larger the buffer size, the more operations can be
undone. Note that different types of operations use
different amounts of memory in the buffer, so the
buffer size cannot be directly related to the actual
number of steps.

Give Warnings

Give warnings allows you to enable or disable
various warning prompts that are displayed in
certain circumstances.

Windows clipboard

If selectedOvation Pro will use the Windows
clipboard, allowing data exchange with other
programs that use it, as well as normal clipboard
operation withinOvation Pro.

Clipboards

Ovation Pro supports multiple clipboards. This
icon lets you set the number of clipboards.

To use the multiple clipboards more easily, install
the Clipboards applet.

Check documents

reload a document, the caret will be at the positiomhese two buttons enable checking of documents

it was when the document was saved.

General choices

Date format | %20 %ST %MO RCESYR

Time format Y0212 Yo% AM

[T Save buffer Buffer size| 9 ¢

W Give warnings

W Windows clipboard  Clipboards | 1
W Check documents after loading

¥ Check documents before saving

Fig. 15.5 - General choices.

for corruption after loading and before saving. If
corruption is detected you are given a choice to
continue or not, selecting ‘No’ will then produce

an error message which describes the nature of the
corruption.

Obviously corruption of documents is undesirable,
however this feature will at least allow you to
avoid overwriting a good copy of a document with
a bad one, or continuing working on a damaged
document.

In addition to checking for corruption, a check is
also made if the document contents have changed
since it was saved. This check can reveal
problems with filing systems.

Both these options should be selected unless you
have a good reason.
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15.6 View Choices Attach Info Palette

Menu=>Misce>ChoicessView If Attach info palette is selected, the info palette
is attached to the document wind¢see 2.7)If
the document window is moved, the info palette
moves with it.

View choices are associated with the way
Ovation Pro documents look on the screen
(fig. 15.6). _ _ _
Flashing Caret If Attach info palette is not selected, the info

palette becomes attached to the screen and doesn't

Flashing caretallows you to have a flashing move with the document window. If the choices
caret, making it easier to locate in the document. 5r6 saved, the position of the detached info palette
Period is also saved.

Period in the time in centi-seconds that the If Allow off-screenis selected, the info palette
flashing caret is switched on/switched off. can move off screen for example when the

Attach Toolbox window is expanded to fill the screen. This may

If Attach toolbox is selected, the toolbox is be useful on a multi-monitor system.

attached to the document wind¢see 2.6)If the  Instant Updates on Path Edit
document window is moved, the toolbox moves If Instant updates on path editis selected,

with it. surrounding text is continually updated as paths
If Attach toolbox is not selected, the toolbox are edited in Path Edit Modsee 8.11)
becomes attached to the screen and doesn't MOVR |nstant updates on path editis not selected

with the document window. If the choices are  g,rrounding text is not updated until Path Edit
saved, the position of the detached toolbox is als@ode is exited. This may be useful if path editing
saved. becomes very slow due to the text reflows.

If Allow off-screenis selected, the toolbox can  ~rosshairs when moving selection

move off screen, for example when the window 'Sif this option is selected large crosshairs will be

expan_ded to fill the screen. This may be useful Ondisplayed whilst objects are being moved.
a multi-monitor system.

“iew choices
¥ Flashing caret I 50 Period
W Attach toolbox W Allow off-screen

¥ Attach info palette | Allow offscreen
¥ Instant updates on path edit

[T Crosshairs when moving selection

Fig. 15.6 - View choices.
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15.7 Text Choices Smart Quotes

Menu=>Misce>Choices> Text If Smart quotesis selected, plain quotation marks

) , ) . in imported text are converted to fancy quotes
Text choices are associated with text editing, text(see 3.3)otherwise they remain unchanged.

styles and text framd$§g. 15.7)
Single Shift Font

Single Shift Fontspecifies the font used by the
single shift font facility(see 3.2)

Overtype

Overtype controls what happens when you type
while there is some text select@ge 3.6)

If Overtype is selected, the selected text is deleted

Text Frame Inset and replaced by the typed text.

Text frame insetis the default inset used by text
frames(see 9.2)If you don't want text frames to
have an inset by default, set this value to 0.

If Overtype is not selected, the selected text is
deselected and the typed text is inserted before it.

Unicode

Rename Styles . . . . :
This determines iDvation Pro uses the Windows
Rename stylesontrols what happens when text ) . .
font manager in Unicode mode. Generally it

containing defined styles is transferred to another

o should be selected. Some of the standard
document containing the same style names, but . )
. ) Ovation Pro characters can not be displayed
with different attributes.

without Unicode. However Unicode support is

If Rename styless selected, a clashing style poor in the Windows 95, 98 and ME series, and
name in the transferred text is renamed by addingiou may find turning off Unicode is necessary.
a number to the end of the name. Windows NT, 2000, XP and later have proper

If Rename styles is not selected, a clashing style Unicode support.
name in the transferred text is discarded, and thesave Ignored Words

style in the destination document is used. If Save ignored wordss selected, the dictionary

Rename Colours of ignored words generated by the spelling
Rename colourscontrols what happens when textchecker | gnor e, is saved with the document
containing defined colours is transferred to whenever it is saved. This means that when the
another document containing the same colour ~ document is re-loaded, previously ignored words
names, but with different colours. are ignored when the document is spellchecked.

If Rename coloursis selected, colours names are If Save ignored wordss not selected, the
renamed, otherwise they are discarded (operatiorflictionary of ignored words is not saved with the

is the same aRename stylesabove). document.
Min length
| Text handling choices Min length sets the minimum length of words
Single shift fDm| Symbol E which will be spell checked.

Check repeated word

If Check repeated wordss selected the spelling
| Rename styles [ Rename colours checker will report repeated words, e.g. the the.

v Smart quotes Font menu show sample

If this is selected a sample of the currently
highlighted font will be shown whilst the font

[ Save ignored words |T = | « | Min length menu is open. Holding dowshift when the font
menu is open temporarily reverses this setting. For
example if you don’t have this option selected you
[v Font menu show sample can press$hift to see a font sample.

Text frame inset | 1mm

[v Overtype [v Unicode

[v Check repeated words

Fig. 15.7 - Text choices.
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15.8 Picture Choices Centre Lock
If Centre lock is selected, th€entre lock option

oMisce> Choi i : It . )
MenuswMisce Choices: Picture in theModify picture dialogue box will be
Picture choices are associated with picture selected by defau{see 10.7)

handling(fig. 15.8) Aspect Lock

Picture Frame Inset If Aspect lockis selected, thAspect lockoption
Picture frame insetis the default inset used by  in theModify picture dialogue box will be
picture framegsee 9.3) selected by defau(see 10.7)

Runaround Error Auto Scale

Runaround error controls how accurately If Auto scaleis selected, thAuto scaleoption in

Ovation Pro traces the picture when usiRicture  the Modify picture dialogue box will be selected
runaround (see 9.7)The value entered is the by default(see 10.7).

average error for each pixel traced. Smaller Valueﬁicture Cache Max size

will give more accurately traced pictures, although ,
the trace will then take longer to complete. Reference if over
Proxy if over

Picture Import with Ctrl ) , ]
These choices are explainedlid.11.

If you import a picture into a picture frame while
pressing Ctrl, the picture is imported at a pre-  Check for Missing Fonts

defined scalésee 10.1)Picture import with This button in the Picture choices window allows
Ctrl specifies that scale. So, for example, if you you to specify that a check will be made for
want to ensure that imported pictures are always missing fonts in graphics.

scaled to 75% of their original size, §atture

; twith Ctrl o 75% If any fonts are missing a warning will be given
import wi rl to 0.

during loading. As with missing fonts in text,
Ovation Pro generates ‘events’ which may be
used to tell a font manager to find and load the
needed fonts. If you have such a font manager
already set up then fonts in pictures will now work
with it too.

There is a potential catch with this feature and

referenced pictures, to check the fonts used, the

graphics have to be loaded, so if you had a

Picture choices document with many large referenced images
T loading it might take a long time.

Picture frame inget| Omm
Fonts which are missing are substituted. So text

2 . .
FDEEE] Efel will appear but not in the correct font.

Picture impart with Ctrl| 1000 9%
™ Centre lock W Aspect lock
[T Auto scale

W Check for missing fonts

Ficture cache max size | 20M LILI
[T Reference if over 200K« 4]
™ Proxy if over 00K Ll;l *El

Fig. 15.8 - Picture choices.
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15.9 Line Choices

Menu>Misce>Choices»>Line

Line choices are associated with line drawing

(fig. 15.9)
Default Line Width

Default line width sets the default width for all
lines drawn irOvation Pro. Choose a predefined
width from the menu, or enter your own value in
the field at the bottom of the me(gee 9.4)

Default Triangle Width

Default triangle width is the default width of the
triangle for lines with arrowheads. Choose a
predefined width from the menu, or enter your
own value in the field at the bottom of the menu.
The width is specified as a multiple of the line

width (see 9.4)
Default Triangle Height

Default triangle height is the default height of
the triangle for lines with arrowheads. Choose a
predefined height from the menu, or enter your
own value in the field at the bottom of the menu.
The height is specified as a multiple of the line

width (see 9.4)

Line choices

Default line width
Diefault triangle width

Default triangle height

Fig. 15.9 - Line choices.

0.25mm

2
4

|t |t |

CHapPTER 15

15.10 Colour Correction Choices
Menuw>Misce> Choices>Colour

In general the colours one sees on screen are not
the same as the colours output by a printer. When
printing RGB (and equivalent HSV) colours must
be converted to CMYK colours. For use on screen
CMYK colours must be converted to RGB.

The conversion from RGB to CMYK is done
usingcolour correction tables.

Colour correction choices lets you select whether
this colour correction should take place or not and
which table will be used.

Use inks to display CMYK coloursis used to
give a more realistic display of CMYK colours on
screen.

See 13.5 for a full discussion.

I Colour correction choices

& lse correction table Mo correction
Table I Typeset ﬂl
[ Use inks to display CMYK colours

Map I SYWOP on coated stock ﬂl

Fig. 15.10 - Colour correction choices.
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15.11 Document Preferences
Menur>MisceoPreferences. .. Ctrl+Shift+P
ChooseMVliiscw>Preferencesto open a dialogue

box that allowvation Pro document
preferences to be configuréih. 15.11)

Preferences are attached to documents, so you
may have different settings for different
documents. When a document is saved, its
preferences are saved with it.

There are three categories of preferences:
General, View andText. Click on the appropriate
icon in the scrolling pane at the left of the
dialogue box, to display all the associated

Preferences. The Preferences are described on the

following pages of this user guide.

Once you are happy with the preferences, click on
OK to apply them to the current document.

Alternatively, click onSaveto apply the
preferences and save them so that they will be
used by default each time a new document is
opened. You will be prompted for confirmation
before the old preferences are overwritten.

K Documontpreforences _______HIE3|

rs

[

I General preferences

Document units | mm

Start chapter number| 1

Chapter/page separator

[~ Auto save every| 3

[~ Prompt for auto save

bl

mins

[« Auto page insert [v Auto page delete

Document feature level I 4 LI;I

Save Cancel

Dk

Fig. 15.11 - The Preferences dialogue box.

DocumeNT PREFERENCES
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15.12 General Preferences confirm that you want to save the document under
MenusMiscesPreferences. ©>General the same name or you can save it under a new

Ctrl+Shift+p ~ Name.

If Prompt for auto saveis selected, the normal
Savewindow will be displayed before the
document is saved. Click @K to save the

Document Units document, or click outside tf&avewindow to
Document unitsspecifies the default units for the cancel.

document. You may choose millimetres (mm), Auto save does not operate if the document has

inches (in) or points (pt) from the menu e -
(fig. 15.13) The chosen units are used whenever qover been saved, or if it has not been modified

: . . Since it was last saved.
measurement is entered into a dialogue box or

menu. They are also used for the page rulers andAutosave also only takes place if at least 10
tab ruler. seconds have elapsed since the last keystroke,

otherwise it is postponed by 10 seconds. This
prevents a burst of typing ending up in Seve
window.

General preferences are associated with the
general setup of the documdfigy. 15.12)

Start Chapter Number

Start chapter number is the chapter number for
the first chapter in the document. If you split a
document into a number of separate files, you m@uto Page Insert/Delete

need to use this option to ensure that each sectiohhese control the automatic insertion of pages
starts with the correct chapter number. when the text in an auto linked text frame chain

overflows the last frame and deletion when there

Chapter/Page Separator isn’t enough text to fill it.

Chapter/page separatoris the character used to

separate the chapter number and page number.
This is used for example in automatic paragraph
numbering(see 5.8)

This feature will be useful if you want a document
which is a fixed number of pages long and don’t
want it to keep changing in size as you work on it.

Another consequence is that with auto page
insertion and deletion turned off, the insert and
delete page entries on the page menu will do
exactly what you tell therfsee 11.8)So if you

If Prompt for auto savedis not selected, the insert a page the document is guaranteed to end up
document will be saved without any user one page longer - because there will be no auto

intervention required, except the first time that th%age deletion of any excess page after the
document is saved after loading. You must then jnsertion.

Auto Save

If Auto saveis selected, the document will be
automatically saved at the interval specified.

| s — Document feature level
eneral preferences .
P The higher the feature level the greater

Document units | mm E functionality the document supports. For example
feature level 5 or higher allows Unicode
Start chapter number | 1 characters to be used in documents. However
Chapter/page separator| - older versions oDvation Pro may not load
documents with feature levels higher than 4. You
| Auto save every| 3 mins can reduce the feature level if you want to produce
[~ Prompt for auto save a document that will work on an old version of
Ovation Pro.
|+ Auto page insert v Auto page delete
v mm
Document feature level 4 jj i
ot

Fig. 15.12 - General preferences. Fig. 15.13 - The Units menu.



Section 15.13 View Prererences 231

15.13 View Preferences Snap to Objects
Menu=Misc=>Preferences. .oView If this option is selected, the edges of objects that
Ctrl+Shift+P are moved or resized will snap to the edges of

. ) _ other objectgsee 8.4)
View preferences are associated with the way the

document looks on the scregiy. 15.14) This option is automatically disabled if grid lock
_ is selected.

Pasteboard Width Guideli Front/Back

This is the width of pasteboard added to each side uidelines to Front/Bac

of each page. The width of the pasteboard above 1 Nis option determines whether ruler guidelines
and below each page is fixed at 10mm. are drawn in front of all objects or behind all

: . . Objects(see 8.4)
This option does not enable the pasteboard, which

is done using an option on thigeewr>Options
dialogue boxsee 7.3)

Menu>View=>Options=>  Ctrl+Shift+O
Ruler Origin X/Y
The ruler origin is normally at X =0, Y =0 i.e.in
the top left corner of the page. You may change
the ruler origin by modifying these values. All

object coordinates i@vation Pro are measured
from the ruler origin.

Snap to Ruler Guidelines

If this option is selected, the edges of objects that
are moved or resized will snap to ruler guidelines
(see 8.4)

This option is automatically disabled if grid lock
is selected.

“iew prefarences
Pasteboard width | 100mm

Ruler arigin %| Omm

Ruler arigin | Umrm
¥ Snap to ruler guidelines
W Snap to ohjects

& Guidelines to front " to back

Fig. 15.14 - View preferences.
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15.14 Text Preferences

Menur>MiscroPreferences..oText
Ctrl+Shift+P

Text preferences are associated with text styles

and formattingfig. 15.15).

Baseline Grid Spacing

This specifies the spacing of the baseline grid

(see 5.4)

Baseline Grid Origin

This specifies the origin of the baseline grid,

measured from the top of the pggee 5.4)

Superscript Size

This specifies the superscript size, as a percentage

of the normal character sitgee 4.4)

Subscript Size

This specifies the subscript size, as a percentage

of the normal character sitsee 4.4)

Small Caps Size

This specifies the size of small caps, as a

percentage of the normal character ¢see 4.6)

Decimal Tab Character

This option specifies up to three characters that

are aligned to decimal taljsee 5.5)

Hyphenation Character

This allows you to enter up to three characters that
will be used for hyphenation. If the icon is left
blank the default ‘-’ character will be used. Words
are broken at this character if they won't fit on a
line.

Text handling preferences
EBaseline grid spacing|  15pt
Baseline grid arigin T
Decimal tab character

Hyphenation character

Superscript size| 55 %

Subscript size| B2 %

Small caps size |BBES %

Fig. 15.15 - Text preferences.
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